
Would the Real Steven Spielberg Please Stand Up?  

Getting Started  
Build a Storyboard 

Movie Maker automatically divides your video into segments to make it easier to drag and drop the 
parts you want onto the storyboard where you put your movie together.   

To build a storyboard:  

1. Import video to your PC. You’ll see your clips in the Collections view.   
2. Double click on each clip to see how it looks in the preview window.   
3. Once you’ve decided which ones you want to put in your movie, click and drag the clips to the 

Storyboard in the order in which you’d like them to appear in your final movie.  
 

 
The Storyboard  

4. To rearrange your clips on the storyboard, just drag and drop them to a different location.  

Edit Your Clips 
Trim your clips to get exactly the footage you need.  

To edit clips:  

1. In the Timeline view, click on the clip you’d like to trim.   
2. In the Preview window, drag the scroll bar slowly and watch as the video 

progresses.  
3. Stop at the point where you want to trim the clip.   
4. On the Clip menu, click Set Start Trim Point.  
5. Now continue to drag the progress indicator until you reach the desired end point of your clip.  
6. On the Clip menu, click Set End Trim Point.  
7.    You will now have your trimmed clip.   
 

 



Add Audio  

 
A music clip in the Collection view  

Do It Yourself  
Get creative and have more fun enhancing your movies with techniques used by professional video 
producers.  

Add Transitions  
You can make your movie look more polished and professional by using transitions to move 
between clips. If you want more pizzazz in your vacation highlights, a fade or spin from one location 
to the next can really add excitement to your video.  

To add transitions:  

1. Build your Storyboard by dragging clips in the desired order.  
2. In the Edit Movie section of the Task Pane, click View video transitions. A selection of 

transitions will appear.   
3. Double-click the transitions to see how they look in the preview window.   
4.  Once you’ve decided which transitions to include in your final movie drag them down to the 

Storyboard and place them in the squares between your video clips.  
 



 
A selection of transitions  

Add Titles and Credits  
You can insert titles and scrolling credits at the end of your movie, just like a professional 
Hollywood film.   

To add titles and credits:  

1. In the Task Pane, click Make titles or credits.  
2. On the next screen, click the appropriate link that corresponds to the place where you 

want to add the title or credits to your movie.   
3. Enter the text you want to appear in your title or credits.  
4. Click Change the title animation, and then select a title animation from the list. You 

can preview them by clicking on them.   
5. Click Change the text and font color, and then select the font you like, as well as the 

color of the text and background.   
6. You can also alter the transparency, font size, and position of the title.  
7. Click Done, and your title or credit will be added to your storyboard.   
 

A title on the storyboard  

Add Effects  
Dozens of effects right at your fingertips give you more ways to enhance your story. 

 
To add titles and credits:  



1.  In the Task Pane, click View video effects. A selection of video effects will appear.  

 
Video effects selection  

2. Double-click the effects to see how they look in the preview window.   
3. Once you’ve decided which effects to include in your final movie drag them down to the 
Storyboard and place it on top of the star in the lower left hand corner of the clip.  
 

Creating Clips  

To make it easier for you to manage and edit video clips, Windows Movie Maker 2 for Windows XP 
divides the video you import to your PC into discrete segments.  

Clips are automatically created if you have selected the Create clips for video files check box when 
you import a video file into Windows Movie Maker 2. If the check box is not selected, the video is 
imported as a single continuous clip, rather than a series of shorter clips. You can use Movie Maker's 
clip detection feature later to divide a video file into smaller, more manageable clips.  

Clips are created in a number of different ways, depending on the video file and video source.  

Video from a digital video camera. If you capture video from a digital video (DV) camera that is 
connected to an IEEE 1394 port, clips are created based on the time stamp inserted in the video by the DV 
camera. If there is no time stamp, a new clip is generated whenever there is a significant change in one 
frame of the video compared to frame that follows.  If you import a DV-AVI file that is time stamped, the 
file is separated into clips according to the time stamp information.  

Capturing video from an analog video camera or Web camera. If you capture video from an analog 
camera or Web camera, a clip is created when there is a significant frame change. This method is used for 
both live and recorded content from an analog source. The length of clips is also based in part on the 
duration of the entire video file: Longer video files will have clips that are generally longer in duration 
than those created when clip detection is used on a shorter video file.   

Windows Media files. If you import a Windows Media file with an .asf or .wmv file name extension that 
includes file markers, a clip is created for each marker. If there are no markers—or only one marker—
clips are generated based on significant frame changes.  The time it takes to detect clips in a video file 



increases as the length of the video file increases. If you click Cancel while clip detection is occurring, the 
process stops at that point in the video file. The clips that have been detected are segmented out. The final 
clip includes all of the video in the file that remained when clip detection was cancelled. You can resume 
clip detection for this part of the file at any time.  

Editing Clips  
A clip is a smaller segment of a larger video file. Movie Maker provides several options for editing 
clips.  

Splitting a Clip 
You can split a video clip into two clips. This is useful if you want to insert either a picture or a 
video transition in the middle of a clip. You can split a clip that appears on the 
storyboard/timeline of a current project, or you can split the clip in the Contents pane.   

 

Combining Clips  

You can combine two or more contiguous video clips. Contiguous means the clips were captured 
consecutively so that the end of one clip is immediately followed by the beginning of the next. 
Combining clips is useful if you have several short clips and want to view them as one clip on the 
storyboard/timeline. You can combine contiguous clips in the Contents pane or on the 
storyboard/timeline.  

Trimming a Clip  

You can hide the parts of a clip that you do not want to appear in your project. Trimming does 
not remove the information from the source material; you can restore the clip to its original 
length at any time. Clips can only be trimmed after they have been added to the 
storyboard/timeline. You cannot trim 
clips in the Contents pane. To trim a 
clip:   

Drag the trim handles to remove the 
unwanted portions of the clip.   

 
 
 
 
 
 

Creating Clips  
You can also create clips from any video 
any time after it has been imported or 



captured in Movie Maker. By separating longer pieces of video into smaller clips, you will make it easier 
to find a specific shot to use in your movie.   

Using AutoMovie  
The new AutoMovie feature in Windows Movie Maker 2 enables you to create a movie almost 
instantly by automatically editing together the individual clips or collection of clips that you select. 
AutoMovie analyzes the selected video, pictures, and music, and combines the different elements to 
make one movie based on the automatic editing style you choose.  

To use AutoMovie, you must first complete the following steps:  

1. Select a clip collection or choose multiple individual clips in the Collections pane or Contents 
pane.   

2. Make sure the clips you chose contain video and/or pictures, as well as at least one audio clip.  
3. Make sure the audio clip is long enough to play for the total duration of all of the clips you've 

selected.   
 
Here’s How To Use AutoMovie  

1. Select a collection or multiple clips in the Contents pane.   
2. From the Tools menu, click AutoMovie.  
 

Or:  

In the Movie Task pane, under Edit Movie, click Make an AutoMovie.  
1. In the Select an AutoMovie Editing Style page, select an AutoMovie editing style.   
2. Under More options, click Enter a title for the movie.  
3. In the Enter Text for Title page, type the text you want to appear as the title.   
4. Under More options, click Select audio or background music.  
5. In Audio and music files, do one of the following:  

• Select an audio or music file from the current list.   
• Click Browse to import an audio or music file on your hard disk into Windows Movie 

Maker 2 to use in your movie.  
• Select None if you do not want any audio or music added to your movie.   

6. If your movie will include audio or music, you can do one of the following:   
7. To increase the audio level of an audio clip on the Audio/Music track, drag the slider bar  

towards Audio/Music.  
8. To increase the audio level of the audio on the Audio track that is part of a video clip,  

drag the slider bar towards Audio from video.  
9. Click Done, edit movie to create the AutoMovie and add the clips to the  
storyboard/timeline.   
 
 
The time it takes for the AutoMovie to be processed and added to the storyboard/timeline depends on 
the duration of the movie, and the size of the audio, video, and picture files. Generally, it will take about 
1/3 the time of the overall length of the clips to complete the process. After you create an AutoMovie, 
you can save it as a movie using the Save Movie Wizard or you can make further edits, just as you would 



when creating a project and movie on your own in Windows Movie Maker.  

Adding Titles and Credits  

Windows Movie Maker 2 for Windows XP includes features that make it easy to add titles and credits to 
your movies. You can add any text that you'd like, including the title of your movie, your name, the date, 
and the names of the actors. You can also place the titles anywhere you want—at the beginning or end of 
a movie, before or after a clip, or even overlaying a clip. You can also specify the length of time that the 
title will appear.  

 

A project with a title that displays before a video clip.  



 

A project with displays as an overlay title over a video clip.  

 



Choosing the Title Animation  
With title animation effects, you can control the way titles play back in your movies. For example, the 
Typewriter title animation displays title text one character at a time.  

Windows Movie Maker includes three categories of title animations:   

Titles, One Line  

As the name suggests, the title animations in this category are best suited for titles that contain a single 
line of text. When you select a title animation from this category, the text area for entering the title 
appears as one large text box. The text you enter then appears all at once in your movie, even if your title 
actually runs to more than one line of text.  

Titles, Two Lines  

The title animations in this category work best for titles that contain two or 
more lines of text. When you pick a title animation in this category, you'll see 
two areas for entering text. The first line of text you enter appears first and 
then the second line of text appears shortly after the first line of text is 
displayed.   
 
Credits  
Movie Maker also makes it easy to add credits to your home movies. When a title animation is selected 
in this category, the text area for entering the credits appears as a small grid. Use the top row to enter 
the title of your movie. The rows below provide two columns where you can enter information about 
your movie. You can use the first column for entering titles such as director and scriptwriter, and the 
second column to enter their names, for example. For each category, if the title will appear as an 
overlay, you'll see the notation (overlay) at the end of the title animation description.   

Entering Titles and Credits  
Here’s how to use title and credit features of Windows Movie Maker 2:  

1. On the Tools menu, click Titles and Credits.  

–or- 

In the Movie Task pane, under Edit Movie, click Make titles or credits.  
1. On the Where do you want to add a title? page; click a link that corresponds to the place where 
you want to add the title.   
2. In the Enter Text for Title page, type the text you want to appear as the title.   
3. Click Change the title animation, and then on the Choose the Title Animation page, select a title 
animation from the list.   
4. Click Change the text and font color, and then on the Select Title Font and Color page, choose 
the font, font color, formatting, background color, transparency, font size, and position of the title.   



5. Click Done, add title to movie to add the title to your movie.   
 

Adding Music   
Adding a soundtrack is a great way to enhance the meaning and excitement of the movies you create. 
With Windows Movie Maker 2 for Windows XP, it's easy to add favorite songs, evocative mood music, 
or any other audio you'd like to include as part of a soundtrack.  

Once you’ve assembled the elements of your home movie on the storyboard, you’re ready to add music. 
Here's how:  

1. In the Tasks Pane, click Import audio or music (or click on File menu, then Import into 
collections)  
2. Your My Music folder will open. Navigate to the song that you want and click on it, then click 
the Import button in the lower right-hand corner. This will bring your music clip into your collection.   
3. Click on the Show Timeline button above the storyboard, or use the View drop-down menu and 
click on Timeline  
4. Drag the audio file down to the Audio/Music track   
5. You can move the audio clip left to right to coincide with a particular video clip. And if the music 
is too long for your video, you can trim it. Simply scroll along the Timeline all the way to the right, so 
you can see the end of the audio clip. Move the cursor onto the end of the song, and a red double arrow 
will appear. Drag the clip to the left as far as you want to create the end point of the music.   
 

 
on the video clip. For example, or you can turn the audio track on the video clip all the way down so that 
only the music is heard, or adjust the levels so that both are audible.  

To adjust the volume of an audio clip  

1. On the Audio or Audio/Music track of the timeline, select the audio clip that you want to adjust 
the volume for.   
2. On the Clip menu, point to Audio, and then click Volume.  
3. To adjust the volume, do one of the following:   

• To reduce the volume, move the Audio volume level slider to the left.   



• To increase the volume, move the Audio volume level slider to the right.   
• To mute the clip, select the Mute clip check box.   
• To reset the volume to the original volume, click Reset.  

 
To adjust the volume of an audio clip relative to the audio from the video clip  

1. Just above the Timeline view, click on the Volume icon on the left.   
2.  A slider will appear, and you can drag it left or right, depending on whether you want 
the audio from the video to be more prominent or the music to be more prominent.   
 

 

Adding Narration  

With Windows Movie Maker 2 for Windows XP, you can easily add a voice-over to your home movies. 
Adding narration lets you use your own words and voice to describe the scene that viewers are seeing.   

To add voice narration to your movie, you need a microphone installed on your PC.   

Once you’ve assembled the elements of your home movie on the storyboard, you are ready to start 
your narration:  

1. On the View menu, click Timeline (or click Show Timeline in the Storyboard section).   
2. Move the playback indicator on the timeline, which appears as a square with a vertical line, to a 
point on the timeline where the Audio/Music track is empty and where you want to begin your audio 
narration.  
3. Click on the microphone icon above the timeline, or go to Tools menu and select Narrate 
Timeline.  
4. To see more options, click Show more options, and do the following:   
5. If you have added other audio clips to the Audio/Music track and you do not want the other 
clips to shift on the timeline, select the Limit narration to available free space on Audio/Music track 
check box.   
6. In the Audio device list, click the audio capture device you want to use. Then, in Audio input 
source, click the line that you want to use.  
7. To adjust the volume of your captured audio, move the Input level slider to the level you prefer.  
8. Select the Mute speakers check box to prevent the audio from a video clip on the timeline from 
playing back over your speakers while you are narrating the timeline. This keeps unwanted audio from 
being captured in your narration.   
9. Click Start Narration and begin narrating the content on the timeline.   
10. Do one of the following:   

• If the Limit narration to available free space on Audio/Music track check box is selected, narrate 
the timeline until the time limit expires.   

• If the Limit narration to available free space on Audio/Music track check box is cleared, click 
Stop Narration after you have finished narrating the contents on the timeline.  

 



 
 

11. In the File name box, type a name for your captured audio narration, and then click Save.  

The audio narration you captured is imported automatically into the current collection and the 
narration is added automatically to the point on the Audio/Music track where the narration was first 
started.  

Capture Video from a Tape in a DV Camera  
Connect your DV camera to your computer; in most cases this requires an IEEE 1394 adapter on your 
PC and an IEEE 1394 cable to connect your camera. On the camera, set the camera mode to play the 
recorded video. (This is often labeled VTR or VCR on a DV camera.)  

1. Start Movie Maker. To start Movie Maker, click Start, point to All Programs, point to Accessories, 
and then click Windows Movie Maker.  
2. On the File menu, click Capture Video. Alternatively, in the Movie Tasks pane, under Capture 
Video, click Capture from video device.  
3. On the Video Capture Device page, in Available devices, click the DV camera.   
4. In the Enter a file name for your captured video box, enter a name for your captured video file. 
Then, in the Choose a place to save your captured video box, select the location where you want your 
video to be saved, or click Browse to select a location.  
5. On the Video Setting page, choose the video setting you want to use for capturing video and 
audio.  
6. On the Capture Method page, click Capture the entire tape automatically. The tape in the DV 
camera will rewind. Capture will begin automatically and ends when the video tape ends.  
7. Select any of the following commands:  

• To separate the video into smaller clips, select the Create clips when wizard finishes check box.  
• To stop capturing before the end of the video tape, click Stop Capture, and then click Yes in the 

resulting dialog box to save the video that has been captured.   
8. To close the Video Capture Wizard, click Finish.  
 
The captured content will be imported into a new collection with the same name as the specified video 
file.  

Capture Parts of a Video from DV Camera Tape  

If you want to capture parts of a video from a tape on your DV camera, rather than the entire 
video, perform the first five steps in the procedure above, and then the following steps:  



1. On the Capture Method page, click Capture parts of the tape manually.  
 To separate the video into smaller clips, select the Create clips when wizard     
 finishes check box.  
2. To prevent audio from playing while capturing video, select the Mute speakers  

check box.  
3. Locate the video and audio you want to capture from your tape by using either  

the controls on your DV camera or VCR or the DV camera controls in the wizard.   
4. To begin capturing video, click Start Capture. The tape will play automatically  

and capture will begin.  
 When the tape reaches the point at which you want to stop capturing, click Stop  

Capture. Repeat these steps for each part of the video tape that you want to capture.   
5. When you have finished capturing, click Finish to close the Video Capture Wizard.   
 
The captured content will be imported into a new collection with the same name as the specified 
video file.  

Capture Video from an Analog Camera or VCR Tape  

Analog video capture is useful when you have older video content, such as VHS tape, and want to 
convert it to digital. Or you may have an older camcorder that only provides analog outputs, such as 
composite or S-Video. Performing analog capture requires a hardware device that can take video input 
from a composite or S-Video signal and convert it to digital data.  

To capture video from an analog source, connect your analog camera or VCR to your computer's capture 
device, and then set the camera mode to play recorded video (often labeled VTR or VCR on an analog 
camera). Start Movie Maker and start the video capture as described in the procedures above.  

1. On the Video Capture Device page:   
 •In Available devices, click the analog device you want to use to capture video. In the  
 Video input source list, click the input line you want to use.  

•If you want to adjust and configure the video capture device settings, click Configure.   
 •In the Audio device list, click the audio capture device you want to use, and then, in  
 Audio input source, click the input line you want to use.  

•To adjust the volume of your captured audio, move the Input level slider.   
2. Where prompted, enter a file name for your captured video, and choose a place to save your 

video. Then select the video setting you want to use for capturing video and audio.  
3. To separate the video into smaller clips, select the Create clips when wizard finishes check box.  
4. To prevent audio from playing over your speakers while capturing video, select the Mute 

speakers check box.   
5. Using the controls on your analog camera or VCR, locate the video and audio you want to 

capture from your tape. In Movie Maker, click Start Capture, and then press the Play button on 
your analog camera or VCR.  

6. When the tape reaches the point at which you want to stop capturing, click Stop Capture, and 
then press the Stop button on your analog camera or VCR. Repeat these steps for each part of the 
video tape you want to capture.   

7. When you have finished capturing, click Finish to close the Video Capture Wizard.   
 
The captured content will be imported into a new collection with the same name as the specified 
video file.  



Capture Live Video  
When your camera is connected to your computer, you can use Movie Maker to capture video directly to 
your hard drive without saving the video to tape first. Start by connecting your camera to your computer 
as described above. Set the mode on your camera to capture live video and audio. (This is often labeled 
Camera mode.) Start Movie Maker on your computer and begin the video capture as described above. 
Choose your device and configure device settings as explained above. Enter a file name for your video 
and choose a place to save your video.   

1. On the Video Setting page, select the video setting you want to use for capturing video and 
audio.  

2. To separate the video into smaller clips after the wizard completes and the video is 
captured, select the Create clips when wizard finishes check box.  
 

3. To prevent audio from playing over your speakers while capturing video, select the Mute 
speakers check box.   

4. To begin capturing, click Start Capture. To stop capturing, click Stop Capture.  
5. Repeat these steps to capture another segment of live video.   
6. Click Finish to close the Video Capture Wizard.   
 
The captured content will be imported into a new collection.  

 

 
 
 
 
 
 
 
 
 
Free Sound Loops for Videos  



 

1. http://www.flashkit.com/loops/ From the home page go to Sound Loops  
2.  Choose from nine music categories:  
3. Under each of the nine categories, the sound loops are further broken into groups of like clips 

Example: Category Techno-Dance—Rave loops.  
4. 15 pages of loops with approximately 8 loops on each page  
5. Displays sound loop name, length, and size.  
6. Students can download multiple clips at one time, but will need to set up a user account, or  they 

can download clips one at a time.  
7. Strongly advise headphone—students can bring their own.  
 
 
 

 

 
 

http://www.flashkit.com/loops/

